BMB173

Problem Set — X-ray Crystallography
Due 2/17/14

1. Determining Distances (5 points)

During office hours today, a wise student pointed out that in a given crystallography
experiment we start out without knowing how big the unit cell is, and we need this to
know the inter-plane spacing for any (hkl) planes. It turns out that you can figure this out
with Ancient Greece-level science (a solid understanding of triangles, a ruler, and an X-
ray home source). So, let’s figure out the length of one dimension in our hypothetical
crystal. Below is a diagram of the Ewald Sphere (now in its full spherical glory) from
Crystallography made Crystal Clear (Gale Rhodes, 2006).

X-ray beam
and c*-axis

hkO plane of
reciprocal lattice

Film plane

Assume the following conditions:
e A=1.5Angstroms
o Fisthe spot 000 (beam stop)
e Risthe spot 100
e The distance from the center of the crystal to the film plane is 1 m
¢ The spacing between the beam stop and point R is 1 mm

o What is the radius of the Ewald sphere?Th

¢ If the plane shown in contact with the sphere at point P is a reciprocal lattice
plane, then P must be the reciprocal lattice point with the same index as R on the
diffraction pattern

e How many times do the 100 Bragg planes cut the unit cell along the horizontal
axis?

o What is the relationship between RF and PO?

RF = the distance from the beam stop to reflection 100 = 103 m.
CF = the distance from the beam stop to the crystal center = 1 m.



Because P is the lattice point corresponding to reflection 100, then the distance PO is
1/d for this plane
Because the radius of the Ewald sphere is 1/A, the distance CO is 1/A

Triangles CPO and CRF are similar triangles so:
RF PO PO 1 A
T o= T o POrA=grA=g

d=2Ax* %:(1.5* 1070m) + % = 1.5+ 1077 m = 1500 A = 150 nm

2. Ruminating upon Reconstruction

a. When we’re looking at a diffraction pattern to perform the Fourier summation in
order to reconstruct the electron density, how do we know how much relative
density is produced by each wave? How do we know what the frequency of each
wave is? (5 points).

The relative density is determined by the wave’s structure factor, or equivalently
the relative darkness of the spot on the detector. The frequency in each direction
is determined by the (hkl) index of the spot (just like each pixel location in a 2D or
3D Fourier transform determines the frequency of its representative wave).

b. If we say that the reflection (120) has a phase of T (180°), what does it indicate
about the location of the contributing electron density? On the unit cell diagram
below, draw the position of the set of atoms that contribute to the density and
reflection. Note that you don’t know where each individual atom is; only the plane
which they contribute to. _(§_ points).

The Bragg planes (120) occupy a given spacing along the unit cell. However, the
atoms which physically have the same spacing in the crystal don’t actually have
to sit on these planes. The phase describes the offset of the atomic positions
from the “ideal” case where they sit on the Bragg plane (6 = 0). A phase of 1
indicates that the contributing atoms actually sit half way between the
corresponding ideal ngg planes.



3. Solving the Phase Problem (35 points)

In this problem, you will use isomorphous replacement to determine possible phases of a
single X-ray reflection from a protein crystal. For simplicity, you will only consider a two-
dimensional lattice and the unit cell will not have any symmetry operators.

You have collected the structure factor amplitudes of a two-dimensional protein crystal.
You have also collected the structure factor amplitudes of a derivative crystal containing
three mercury atoms bound to the protein. The Patterson map shown below is a
difference map between the structure factor amplitudes for the mercury derivative, |Fen],
and the native protein crystal, |Fp|. In other words, it is a map of |Fpu|— |Fp|, Assume that
the mercury atoms do not perturb the protein structure, so that the peaks correspond
only to mercury inter-atomic vectors.

a) Why must the extra atom(s) for isomorphous replacement be heavy atoms? What
must they not do to the protein structure? (2 points).

The extra atom(s) only appear at one or a few places in the unit cell. They must
therefore diffract strongly to produce a detectable change in the intensities of the
diffraction pattern. Since diffraction intensity depends on the size of the electron
cloud, heavy atoms are ideal for this purpose. However, the heavy atoms must not
change the structure of the protein or else of course the new diffraction pattern is
incompatible with the original — hence, the protein-metal crystal must be
isomorphous with the original protein crystal.

b) (10 points)

! 1

The coordinates of the six peaks on the map are:
- u=0.3, v=0.7
- u=0.9, v=0.6
- u=0.7,v=0.3

- u=0.4, v=0.1



- u=0.1, v=0.4

- u=0.6, v=0.9

Following the steps below use this Patterson map to calculate the real space positions of
all three mercury atoms in terms of x and y, the fractional unit cell coordinates.

Things to know about Patterson maps:

--- If an atom as is present at the position (x, y) in real space, and a second atom a;

is present at position (x + u, y + V), then in the Patterson function there will be a
peak at (u, v), representing the vector a; — a1, and a second peak at (-u, -v),
representing the vector a; — a,.

Everything is considered in fractional coordinates. For example, a value of -0.3
is equal to 0.7 in an adjacent unit cell.

How to solve the Patterson map:

--- There are no symmetry operators in this problem, so there are no peaks between

symmetry related atoms. The choice of origin is arbitrary, which means the
position of the first atom, a;, can be set to x = 0, y = 0. Note that the choice of
atoms 1, 2, and 3 is also arbitrary. The work you show will depend on your
starting peak, but you will get the same three atomic positions regardless of your
choice.

Designate a peak on the Patterson map to be the vector between the first and
second atom (a; —a1). Ifaiisatx =0,y =0, thenazisatx = u, y = v. Then, from
the remaining peaks, determine which one represents the vector from the second
atom back to the first (a; — az).

There are four peaks remaining: two relating the first atom to the third atom (az —
a; and a: — az) and two relating the second atom to the third atom (az — a- and a;
— az). Guess and check to assign the remaining peaks. Guess which peak
corresponds to the first and third atom vector (az — a1), and then predict the
coordinates for the third to first atom vector (a1 — as). If no peak is present at the
predicted location, guess again. Repeat this process for the second to third (as —
a) and third to second (a.— as) vectors.

The model is complete when all Patterson peaks are accounted for. Please show
your assignments for what each peak corresponds to (az — ai1, a> — as, etc).



There are many solutions to this Patterson map. They all describe an equivalent lattice
(or its enantiomer) and differ by which atom is treated as the origin.

Some possible solutions:

Atom 1 (x y) Atom 2 (x y) Atom 3 (x y)
0,0 0.3,0.7 0.4,0A1
0,0 0.3,0.7 09,06
0,0 0.7,03 01,04
0,0 0.4, 0.1 0.1,0.4
0,0 0.1,0.4 0.4,041

c) (8 points) Calculate the amplitude and phase of Fuy(5 6), the scattering from the
heavy atom substructure alone for the reflection at h =5, k = 6 in the crystal

re®® = r(cos + isinb)
F(hk) — ZﬁEZHi(hxj+kyj)
-

diffraction pattern. Suppose the atomic scattering magnitude of mercury (f;) is 70.
You can use the equation below to calculate scattering from j number of atoms,
where fj is the atomic scattering magnitude (70), h and k are the Miller indices (5,6)
and x and y will be the real space positions determined in part A. To add up the
exponential terms, you can use the following relationship (in radians!):

Your sum will be a vector in the form of x + iy. To solve for the amplitude and phase, plot
this vector on a graph where the x-axis represents the real component and the y-axis
represents the imaginary component. The phase of F(hk) is the angle between the x-axis
and the vector, and the amplitude of F(hk) is the length of the vector.



Each solution from part A will result in the same calculated value of the heavy atom
structure factor magnitude, but they will have different phases. Full credit is given based
on consistency.

Example:
F(hk) = fiexp[2ri(hxs+Ky4)]+ fiexp[2ri(hxa+Ky2)]+ fiexp[2rti(hxs+Kys)]

F(5 6) = 70 cos[2m(5x:+6y1)] + 70 Cos[2n(5x2+6Y2)] + 70C0S[2r(5x3+6Ys)]
+ 70isin[2r(5x;+6Y1)] + 70isin[2r(5x2+6Y2)] + 70isin[2m(5x3+6Y3)]

For the first solution from part A:

F(5 6) = 70 cos[2n(5x0+6x0)] + 70 cos[2r(5x0.3+6x0.7)] + 70cos[2m(5x0.4+6x0.1)]
+ 70isin[2r(5x0+6x0)] + 70isin[2n(5x0.3+6x0.7)] + 70isin[2n(5x0.4+6x0.1)]

F(5 6) = -8.26-107.7i

IF(5 6)I2 = (-8.26)?+(107.7)?
IF(56)l =108

a(5 6) =tan(107.7/8.26) + 1 = 4.64 radians

d) (7 points) The amplitude of the native structure factor at h = 5, k = 6 is given by |Fp(5
6)| = 66.57. The mercury derivative amplitude is |Fpn5 6)| = 60. Draw a Harker
construct to demonstrate the two possible phase angles forthe h=5, k=6
reflection. Calculate the two possible angles using the following equation, where a is
the phase angle in radians:

O = dHg + cosL[(|Fpu|? = |Fr|? ~ |FHgl)/(2|Fr|(|FHg|)]
Your Harker construct should illustrate Fp, the structure factor of the native protein, Fug,

the structure factor of the mercury atoms, and Fepy, the structure factor of the mercury
derivative protein.



Example

Qp = Qug + COS ' [(IFpugl® - IFpI® - IFugl®) / (2IFgl IFygl)]
ap=4.64 + cos [(B0°— 66.57°- 108%) / (2 x 66.57 x 108)]
ap=4.64 +262=7.260r2.02

The geometric meaning of the Harker construct depends on whether you plot +Fpgor
—Fug. The following diagrams are drawn to scale for the example solution.

IFepgl

e) (3 points) In part ¢, you solved for two possible phase angles, represented in your
Harker construct as the intersection of two circles. Draw a Harker construct that
represents the resolution of this phase ambiguity by using a second heavy atom
derivative.



Answer

f) We have made the assumption above that if we subtract the diffraction spots of the
protein crystal from those of the protein-metal crystal, we get only the diffraction
spots from the metal (heavy atom). Mathematically, this was written |Fen|— [Fp| = |FH].
Recall that the structure factor is a vector in the complex plane. Is the general
statement |A + BJ - |A| = |B| true for all vectors? Under what circumstances would it
true for the three structure factors? Is it reasonable to make this assumption? (5
points).

The general statement is false (you can demonstrate to yourself by coming up with
two random vectors, taking their magnitude, and then taking the magnitude of their
vector sum — unless you were very lucky, the magnitudes should be different). The
only condition by which the equation is true is if the two vectors are parallel (they
would then add directly end to end) — in other words, if the phase between them is
zero. However, if the magnitude of one vector is small relative to the other, then the
sum will not deflect significantly from the original, and we can make the
approximation that the angle is zero, keeping in mind that this is not strictly speaking
true.



4 (5 points) Phase ambiguity can be resolved by taking advantage of anomalous
scattering by heavy atoms in your crystal, as represented in the Harker construct
shown below. Describe the additional Fpxe+), FrH), and 7’ terms, and under what
experimental conditions they can be expected to be observed.

Fel \
a,

Anomalous scattering is a phenomenom which occurs when electrons absorb and
reemit X-rays having an energy close to that of the electron’s nuclear binding energy.
The re-emitted X-rays have the same wavelength as the incident radiation phase shifted
by 90°. Anomalous scattering causes a breakdown in Friedel’s law (Fpr+# Fp-), which can
utilized to provide phase information. Fer+and Fer-are the structure factors for the
derivative crystal Friedel pair, and f’ the anomalous scattering component.
Experimentally, X-rays need to be tuned to appropriate absorption energies for the
specific heavy-atom in order to obtain sufficient anomalous scattering.

5 (5 points) While completing your experiments, the structure of a homolog with 90%
sequence identity to your protein is published. What phasing technique could be
performed with this information to solve your structure?

Molecular Replacement
6. Model Building (25 points)
In this problem, you will use Coot to fit a protein segment to an electron density map.

Navigating in Coot:

Detailed instructions on using Coot are available at
http://www.ysbl.york.ac.uk/~emsley/coot/doc/user-manual.html

Once a PDB file has been opened, the most common navigation methods are:
Left-mouse drag Rotate view

Ctrl + left-mouse Translate view

Shift + left-mouse Label atom

Right-mouse drag Zoom in and out

Ctrl + shift + right-mouse drag Rotate view around screen

Middle-mouse Center on atom



e Scroll wheel Increase and decrease map contour level

Coot can directly download coordinates and electron density maps from the PDB (Note: If this
does not work for you, please just proceed to the problem set.) View the X-ray crystal structure of
GFP to familiarize yourself with the controls:

File > Fetch PDB & Map using EDS. Enter 1GFL and click ‘Get it’. Wait a few seconds for it
to download. You will be presented with coordinates and two maps, a 2|Fo| — |Fc| and a [Fo| — |Fc|
map. Hide the |Fo| — |[Fc| map.

Draw - Display Manager. Uncheck the display box for the second map, labeled FOFCWT. Try
zooming in and out, centering on various atoms, and changing the contour level of the map. The
contour level sets the minimum electron density that must be present at an xyz point for the
gridded map to be drawn around it. The sigma value indicated in the top right corner as you
change contour level is signal over noise, so be careful interpreting maps with sigma less than 1.

Model building

Before proceeding, delete the GFP map and coordinates:
File = Close Molecule/Map. Select everything and click ‘Delete Marked Molecules & Maps’.

Download the electron density map. You are given a 2.0 A resolution electron density map
(Download BMB173 2015 PS6.zip from http://saf.bio.caltech.edu/bil73/. Extract the files
somewhere on your computer to use for this problem set). It was generated using experimental
intensities and calculated phases from a refined model.

File > Open Map. Select map.map and click OK.
Edit > Map Parameters. Change Map radius from 10.0 to 20.0 and click OK.

File & Open Coordinates. Select center.pdb, make sure ‘Recentre on Molecule’ is selected, and
click OK.

File = Close Molecule/Map. Check center.pdb and click Delete Marked Molecules and
Images.

Zoom in and out of the fragment to familiarize yourself with its shape. Increase the contour level
until you can clearly identify the chain. This region is a 21-residue sequence of an a- helix and -
strand that is located within the following sequence:
MTLGLDLKGGLRIMAAGDVFRAAASNELQIWAARTGCEIVVIRQPNDQYQF. You will
need to determine its identity. You will start building your structure from an idealized helix. Note:
In previous versions of Coot, the program could automatically recognize helical density and build
a polyalanine helix into it. This doesn’t always work, so you have been provided with a helix.



File > Open Coordinates. Select helix.pdb, make sure ‘Recenter’ is checked, and click OK.
There will now be a helix of 10 alanines modeled into the density. At this point you will need to
identify which range in the sequence given above that this density represents. Look at the side
chain density. There is at least one unambiguous side chain present in the helix. As you identify
residues, change them in your model.

Calculate - Model/Fit/Refine. This will bring up a tool box. Select Mutate & Autofit and then
click on a residue (sometimes it needs to be clicked twice) and select the new amino acid from
the list that appears. Mutate all the residues in the helix as you identify them. Afterwards, you
will refine the model.

Calculate > Model/Fit/Refine. Select Real Space Refine Zone. Click on a residue and then a
second residue 4-5 amino acids down the chain. Check the presented model and make any
changes if necessary by clicking on and pulling the white model. Click OK when you are done.

Calculate - Model/Fit/Refine. Select Regularize Zone. Click on a range of residues as before to
idealize geometry.

Use these two tools to refine the entire helix. All the side chains should be modeled into the
density, and there should be no major errors in geometry. Now build the connecting B-strand.
Make sure that the side chain of the last residue of your helix is in side chain density and not
main chain density. Change your model if required.

Calculate > Model/Fit/Refine. Select Add Terminal Residue. Click the last residue of your helix
going towards the sheet.

A white alanine residue will appear in the window. You can position the residue by clicking and
dragging, and when you are happy with its location hit OK in the pop-up window. Use the
Rotate/Translate command in the Model/Fit/Refine window to roughly orient the residue so
that the side chain is pointing in the right direction, and not into main chain density.
Rotate/Translate brings a window with sliders that you can use to move and twist the residue.
You can also move the residue by clicking and dragging. Use the Mutate & Autofit command to
change the alanine to the appropriate residue, and use the Real Space Refine Zone and Regularize
Zone tools to fit. Complete the beta strand.

There are also two more residues at the other end of the helix. Be sure to build those too.

Validating the Model

To check your work, you can evaluate the geometry of your building by examining the
Ramachandran plot:

Validate > Ramachandran Plot. Select the pdb file for your helix. Coot will automatically
generate a plot. Check to make sure your amino acids have phi and psi angles that fall in the
preferred regions of the map. Amino acids that fall in the allowed regions are acceptable, but
outliers should be fixed. The map will expand to allow more phi and psi angles if the cursor is
pointed at a glycine. Conversely, the map will contract to exclude certain phi and psi angles if a
proline is selected (there are no prolines in this sequence).

Coot also features tools that evaluate how well the model fits the density:



Validate - Density Fit Analysis

The resulting graph will plot the errors in density fit. Manipulate your structure to minimize
errors in the density fit.

You will be evaluated on the quality of your model’s primary sequence, Ramachandran plot, and
Density Fit Analysis (these graphs can be generated using only your submitted pdb file and the
density map, so there is no need to turn these in). When you are finished with your structure, go
to File > Save Coordinates, click on Select Filename, and save your model as your
firsthamelastname.pdb (I would be danpiraner.pdb). Email me your coordinate file
(dpiraner@caltech.edu).

Answer
The correct sequence is MAAGDVFRAAASNELQIWAAR.
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4. Model Validation/Interpretation (15 points)

a) (5 points) What is the R-factor? How is it calculated?
The R-factor iIs a measure of agreement between a model and data
21~ o
er —
2JF]
ki

b) (5 points) Why is Riree Superior to the R-factor? What would be the approximate target Riree
value during refinement for a 2.5 A crystal structure?


mailto:dpiraner@caltech.edu

Rree ensures that the R-factor is not being artificially reduced by only being calculated on
5-10% of the data that has been omitted from refinement. An approximate target would
be 25%

c) (5 points) State the resolution required to distinguish the following features in an electron
density map:

-Individual atoms

-All side chains

-Larger side chains

-Secondary structure elements

-Individual atoms: <1A

-All side chains: 1-3A

-Larger side chains: 3-4A
-Secondary structure elements: 4-84A



